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padonyecknnm nHtepdenc ANSYS
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YTo MOXHO AenaTtb B rpacdhnyeckom uHtepdeunce
ANSYS: MHTepPaKTUBHbIN PEXUM
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You can do things
graphically using
the menus

at the top /
and the side

of the screen

This will often bring
up a dialog box—"]
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or ask you to pick
things with the
cursor
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NOTE: You can change font size using the MenuCtrls > Font Selection menu



OcHoBHbIe okHa ANSYS: graphical user interface m
output window

! Utility Menu ‘
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Icon Toolbar Menu |

] y DYNA Utility #2nu (MyFEA) Input Line H Raise/Hidden Icon gz
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MEMORY REQUESTED ¢MB> @
GRAPHICS DEVICE REQUESTED & ROM Tool .
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Graphics Area ‘
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/INPUT FILE= D:~PROGRAM FILES
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the GUI menubap

the GUI status
reating the GUI Graphics Conte|
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Creating the GUI toolbar
Creating the GUI toolbar —
ICreating the GUI toolbar —

ANS|
Creating the GUI toolbar — “ANS
Welcome to ANSYS
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HayanbHble napamMeTpbl

Set initial parameters:

1) Utility Menu - File 2 Change Jobname... or Change Directory...(In case you

forgot when you started ANSYS.)

Utility Menu - File 2 Change Title... (This step is not necessary, but it is a good idea.
The Title will appear on plots and in other output files.)

ANSYS Main Menu 2 Preferences = Set the Preferences for GUI Filtering (This
step 1s not necessary, but it 1s a good 1dea. Commands not related to a particular analysis
type will be filtered out of the GUI. In this class, we will perform Structural and Thermal
analyses. Also, we will generally use the h-method Discipline option.)

i\ Prele rences for GUI Filbering |
[KEILPMETH] Prafereroes For QULRkerng
Troy i discipinalsh ko shiws i bhe LT

Elecremagnstc:

Moce: IF no individual discipines are sslactad thay il 2l chow,

Discipline ootons
& h-Mathod
™ p{iethod Sk,

" p-Method Eledr.
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dannoBasa cuctema ANSYS file system

s Database and Files: The term ANSYS database refers to the data ANSYS
maintains in memory as you build, solve, and postprocess your model. The database
stores both your input data and ANSY'S results data:

— Input data -- info you must enter, such as dimensions, material properties, and load
data.

— Results data -- quantities that ANSYS calculates, such as displacements and stresses.

* Typical files in Ansys

jobname.db, .dbb: Database file, binary. Compatible across all supported platforms.
jobname.log: Log file, ASCII. Contains a log of every command issued during the
session. If you start a second session with the same jobname in the same working
directory, ANSYS will append to the previous log file (with a time stamp).

jobname.err: Error file, ASCII. Contains all errors and warnings encountered during
the session. ANSYS will also append to an existing error file,

jobname.rst, .rth, .rmgq, .rfl: Results files, binary. Contains results data calculated by
ANSYS during solution. Compatible across all supported platforms.



ba3a gaHHbIX npoekta ANSYS

m CoxpaHeHune npoekTa: komaHaa SAVE nnun kHonka SAVE DB
m [IpoeKkT coxpaHsieTca B pann ¢ pacumpeHuem .db

m [1ns OTKpbITUA MMEIOLLLErOCs MPoeKTa HY>XHO BblbpaTb Resume
from. Ecnn B Product Launcher yxe 0Obif10 3a4aHO UMSI NPOEKTA,
TO BblOpaThb File->Resume nnn HaxaTtb kHornky RESUME_DB

* You can save AN3SYS models as a database file
ThIS cdan bE dl':'rlE' here ~— Bl Sewx L Po Podis ‘dkPune Pe
.

G| oF B A & & 7 BEl
or with the SAVE command —— T

+ Once you have done this if you list the directory
contents it now contains a file: file.db

+ You can resume from your database each time
you start ANSYS

File > Resume from OR RESUME




O6wasn npouenypa mogenupoBaHna B ANSYS

m Preprocessor
m Solution
m Postprocessor

ANSYS Main Menu - Preprocessor

1) Define Element Type

2) Define Real Constants (if necessary)

3) Define Material Properties

4) Create the geometric Model (define in ANSYS or import
geometry from Pro/E or SolidWorks)

5) Create a Mesh for the model

OM5YE Man Menu

&

& Preferences
=R cprocessor
A Element Type

i Real Constants
il Haterial Props
Bl Sechions
& MModeling
Bl Meshing
H checking Cirls
H Murmnbering Cirls
H Archiwe HModel
H Coupling /' Ceqn
Bl Mulki-field 5=t Up
B Loads
B Physics
Bl Path Oparaticns
Solution
Leneral Postproc
TimeHist Postpro
Topelogical Opt
ROM Tool
Design Opt
Prob Design
Radiation Opt
F Rum-Tinne Staks
B session Fditor




O6wasn npouenypa mogenupoBaHna B ANSYS

m Preprocessor
m Solution
m Postprocessor

ANSYS Main Menu =2 Solution

1) Define Analysis Type (static, harmonic, transient. efc.)

AMSYS Main Menu

@

E Preferences
Preproocssor
Efsclution
i Bnalysis Type
i Define Loads
A Load Step Opts
il SE Management (CH5)
B Results Tracking
il Solwe
f “anual Rezoning
B HMulti-field St Up
B Dioonoskics
B Unabridged Menu
General Postproc
TimcHist Postpro
Topological Opt
RO Tool
Design Opk
Prob Desiogn
Radiation Opt
Run-Timec Staks
E] Session Editor

2) Detine Loads (apply loads and constraints/boundary conditions)

3) Solve the model (run the anaylsis)




O6wasn npouenypa mogenupoBaHna B ANSYS

m Preprocessor
m Solution
m Postprocessor

ANSYS Main Menu =2 General (or TimeHist) Postprocessor

AMSY S Main Menu

@|

Bl Preferences
Preprocessor
A Solution

=RGeneral Postproc

B Data & File Opls
B Results Surmmary
A Read Results

B Options for Dutp
B results Viewer

H Load Case

A Check Elem Shape
B Write Results

B ROM Dperations
H Fabigue

M Define Modify

H Manuial Resoning

A TimeHist Postpro
H Topalogical Dpt
H RO Tool

n Opt
Iesign
Lion Opt
ime stalts

1) Read Results (extract results from the results file, and read mto  nediter

the database file)

2) Plot and/or List results of interest (e.g., deformed geometry.,

stresses, strains, displacements, reaction forces, temperatures, etc.)

12



'pachnuyeckun BBOA AaHHbIX

Try it! From the side menu select:

Freprocessor = Modeling = Create = Areas = Rectangle = By 2 comers

This should bring up this dialog box

WP X and WP Y are the coords of
the bottom left corner of the
rectangle

Type a value for these and the width
and height and click OK

You should get a cyan rectangle

13



Ucnonb3oBaHue komaHa B ANSYS

m BmecTO MHTEepPaKTUBHOIoO pexnma MOXHO UCNOSNb30BaTh
KOMaHAbl

s KomaHAabl 3anucbiBalOTCA HAa BCTPOEHHOM Ai3blKe
nporpammupoBaHua APDL — ANSYS Parametric Design
Language

+ |f you type a command in the command box,
ANSYS will tell yuu what it expects as input data

ANEYS Unlwersily Kesesrch Uiy e

Ie BN IR ¢ o = OFER, WO ORNES I HEIGHT. DEFTH
0| = 2l ] & & T h-:4\-_ =| E| @

« Typing the command in has the same effect as
running it graphically and the command will also
be stored in the log file as before

« To get help, simply type help in the command
box, or use the help menu to select Help Topics

14



BxoaHble channbl (input files) Ansys

m Bce aTtanbl mogenmpoBaHMst MOXHO 3anucaTtb B Buae
KoMaHA n cobpaTtb X B ogHOM BxoaHoM dhawune (input file)

m BxogHoun chann — 3To 0ObIYHbLIU TEKCTOBbIN hanrs, OH
AOSMKEeH UMeTb paclumpeHue .inp unum .txt

+ You can programme in ANSYS using input files

« These are just text files containing a list of ANSYS
commands:

Iplate: ANSYS input file for plate with hole

/FILNAM plate | Name the file

/[PREFT | Enter the preprocessor

ET,1,PLANE4Z2 I Define the element type - 4 node solid element
UIMP,1,EX, , 200000, | Define material properties

K.1,2.5,0,, 1 Define keypoints

LARC,1,2,11,2.5, | Define arcs

LSTR, 1, 4 | Define straight lines

AL 36,411 Define areas

lesize,3,,,15 1 Define mesh size

+ Purple text is comment (designated by ‘I') for info only
15



[MpenmyuwiecTBa KOMagHOro pexmma n paboTou ¢
BXOAHbIMU hannamu

m BxopgHble hannbl yaoOHbI Ans BHeCEeHUs1 USMEHEeHUN B
pacuyeTbl

« They are small, large models can be built with
only a few commands

- They allow you to review what you've done easily
« They allow you to modify models very quickly

| have built and meshed a square in ANSY'S,
now | want to change the length of the model

1"" |

Graphically with an input file

Either: Modify keypoints and then Change 2 values in input file and run
again:

BLC4, valt | vai2 , val3, val4

remesh the areas of the model

Or: Start again from scratch

File > Clear and start new File > Read input from




"
Ucnonb3oBaHMe napameTpoB

« Parameterisation can be very useful

[PREFT
ET,1.42

Ine
xlength = 10
yiength = 20

rameters of my problem

We can define the mesh and
geometry using just these 4 values

xmesh =5
ymesh = 15

ILse the parameters to define geometry and mesh the model
BLC4, -xlength'2 | -yvlength/2 |, xlength |, vienagth
LSEL = loc,x 0

LESIZE all,, xmesh

LSEL 3 locy,C

LESIZE . all,, ymesh

AMESH,all

17



'_
TpexmepHoe U goBymMepHoe moaenupoBaHue

[Nepexon K AByMepHON NOCTaHOBKE:
m [lnockoe HanpsixeHHoe cocTosiHue (plane stress)
m [nockasa gedopmauma (plane strain)

s OcecMMMeTpUYHOCTb (axial symmetry) e

~
-~
~
-~
-~
-~
-
~
-~
~
-~
-
-~
-~
-~
-~
-~
-~
-~

section plane -

section plane

Plane Stress Plane Strain Axisymmetric

18



" _
TBepaoTenbHOEe U KOHEYHO-31IeMeHTHOoe
MoaernupoBaHue

m TBepaooTenbHasa mogensb (solid model)
m KoHeuHO-3anemeHTHas mogensb (finite element model)

m Solid model of a bracket m Finite element model of a bracket

Iﬂ///Elemen’[

— Node

@

19



TBepaoTenbsHoe moaenupoBaHue B ANSYS

-

Be defined as the process of creating solid
models in CAD system.

Areas ‘

o Definitions
Lines

—A solid model is defined by volumes, areas, -
lines, and keypoints.

—Volumes are bounded by areas, areas by
lines, and lines by keypoints.

—Hierarchy of entities from low to high as
keypoints < lines < areas <volumes

Keypoints ° °

/Y

ARG

—You cannot delete an entity if a higher-order entity is attached to it.

Also, a model with just areas and below, such as a shell or 2-D
plane model, is still considered a solid model in ANSYS

terminology.

20
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MeToabl TBepaoTenbHOro mogenupoBaHua (solid
modeling) B ANSYS

m MoagenupoBaHue cBepxy BHU3 (top-down)
m MopgenupoBaHue cHnly BBepx (bottom-up)
*»» Top-down modeling

starts with a definition of volumes (or areas), which are then
combined in some fashion to create the final shape.

Input entities Boolean operation Output entity(ies)
< Bottom-up modeling
starts with keypoints, from which you “build up” lines, areas,

etc.
» » I
e L I
* »
21




" N
NMpumutuebl ANSYS

The volumes or areas that you initially define are called primitives,
which are basic entities for the top-down method. ANSYS contains
the following 2D and 3D primitives:

- oe

Rectangle Circle Polygon

o L all

Block Cylinder Prism

Cone Torus

22



" J
byneBbl (nornyeckue onepauuu) npum
MoaenupoBaHumu ceepxy BHU3 (top-down method)

E Medeling

The final shape of an object is usually not as simple ~ =ceae

El Operate

as primitives. However, it is likely doable to @ Extrude

combine a number of primitives through a series of (=Z==

[ Intersect
proper Boolean operations. The “input” to Boolean A ract
operations can be any geometric entity, ranging @ cloe
from simple primitives to complicated volumes '
generated in previous steps. \_E Show Degeneracy /

/

* Boolean operations are computations involving combinations
of geometric entities. ANSYS Boolean operations include add,
subtract, intersect, divide, glue, and overlap. All Boolean
operations are available in the GUI:

Main Menu > Preprocessor > Modeling > Operate > Booleans

23



HekoTopble 6yneBbl onepauuu

4

D)

» Add: Combines two or more entities
Into one.

D)

4

D)

% Glue: Attaches two or more entities by
creating a common boundary between
them, which is uesful when you want to
maintain the distinction between entities
(such as for different materials).

4

L)

% Overlap: Same as glue, except that the
input entities overlap each other.

% Subtract: Removes the overlapping
portion of one or more entities from a
set of “base” entities, which can be
useful for creating holes or trimming off
portions of an entity.

B ANSYS

24



" J
3agaHve Tuna KoHeyHoro anemeHta B ANSYS

Element Type
The element type is an important choice that determines the following element characteristics:
e Degree of Freedom (DOF) set. A thermal element type, for example, has one dof: TEMP,
whereas a structural element type may have up to six dof: UX, UY, UZ, ROTX, ROTY, ROTZ.
e Element shape -- brick, tetrahedron, quadrilateral, triangle, etc.
e Dimensionality -- 2-D solid (X-Y plane only), or 3-D solid.
e Assumed displacement shape -- linear vs. quadratic.

To define an element:
Main Menu>Preprocessor>Element Type> Add/Edit/Delete>Add

Element Types
Defined Element Types: Library of Element Types ]
11 1 SED Lirary of Element Types - -
ptions... | Delete |
Element type reference number
0K Apphy Cancel Help
Cloze | Helg | Q | |

25



" J
TNbl KOHEYHO-3JIEMEHTHOro pa3buneHus:
cBobopHoe (free) un perynapHoe (mapped)

= C80600HbIM Ha3blBaeTCS pasdbueHne, KoTopoe He UMEET OrpaHNUYEeHnn Ha
doopMy 3NEMEHTOB N HE UMEET 3aaHHOro wabnoHa ceTkn. Obbli4HO cBOBOAHOE
pa3dbuneHne ncnonb3yerca ana obnacren n o6bemoB crnoxHom dopmebl. Ongd
cBobOOAHOro pasbmeHna 0ocTaTouMHO 3a4aTb CPeaHUN pa3dMep KOHEYHOrO
afeMeHTa.

» PezyrisipHoe pa3bueHue onpependaeTcsa 3agaHHON OOPMON KOHEYHbIX
9NIEMEHTOB (Hanpumep, TOMbKO TPEYronbHUKN UMK TOSbKO YETbIPEXYTONbHUKU B
crnydae pasdbueHust obrnacten, Tofbko rekcasapbl B criyyae pasbrneHnsa o6 bemMoB)
N 3aaHHbIM LLABIOHOM KOHEYHO-3NIEMEHTHOWN CETKU C YETKUMUN «psaaamMny
9NTEMEHTOB.

Free mesh Mapped mesh

26
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PerynapHoe pa3bueHue obnacreun

Simplified mapped meshing (AMAP)

Picked

Area mapped meshes ;
keypoints

L1

L

L4

/"'
Ls

Picked
keypoints

Examples of transition mapped quadrilateral meshes

FEEER SN A EHER
1 o SeHA7 d == d
0050000 R U HEReeT
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PerynapHoe pa3bueHue obnacreun: gonycTuMblie
waodnoHsbl transition mapped mesh

N2

N4

N3

Sde 10 has N7 divisions vhere

Side 2¢ has N2 divisions vhere
Side 3: has N3 divisions vhere

£

b

d

/
|

S

C

a
b
C

N1

N4 =13

N3

N

\
N\
¢ 1—

h

b

d

a

/s
—
|
|

/s
s

b

S

c

|
N1

N2=bl4 and the difference
betveeen M1 and N3 is even

N2

M1
N2
N3
M4

ML Gl P Ly

Side 10 has N7 divisions

Side 20 has N2 divisions
Side 3 has M3 divisions

Side 4: has M4 divisions

Side 4: has N4 divisions vhere
{that is, N2-N4 =N1-N3

For example:

M1 =a +cC

M2 =h +cC
N3 =a

M4 =h

where N1 =a +2%

vhere N2 =
vhere N3 =a

vhere N4 =c

(that is, N2=Rl4 and the difference
betveen M1 and N3 is even)

For example:

=
I wn

3
4
2

=

(%]
nmwwn
P L P —

]

28
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PerynapHoe pa3bueHue oo6bemoB

; Opposite edges
4| = must have
equal number of
divisions

(@ Brick Shaped Yolume

Edges on sides must have
equal number of divisions

Number of
divisions must
be equal and
even on all

Edges on face
must have even _—* edges
and equal number
of divisions
() Prism Shaped Volume (C) Tevahedral Shaped Yolume

29



PerynapHoe pa3bueHue o6bemMoB: transition

mapped mesh

30
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[Mpumepbl cBOOOAHOrO pa3dbneHus oobnacren

31



NMpmepbl cBOOOAHOIO pa3dbneHnsa oo emMoB

32
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KOHTpONb NMNOTHOCTb KOHEYHO-3JIEMEeTHOro
pa3bouneHus (Mesh density control)

+» Mesh Density Control

ANSYS provides many tools to control mesh density, on a global and local level:
—Global controls: SmartSizing; Global element sizing; Default sizing

—Local controls: Keypoint sizing; Line sizing; Area sizing

To bring up the MeshTool:

Main Menu > Preprocessor > Meshing > MeshTool

7

<+ SmartSizing: by turning on SmartSizing, and set the desired size level. Size
level ranges from 1 (fine) to 10 (coarse), defaults to 6. Then mesh all volumes (or
all areas) at once, rather than one-by-one.Advanced SmartSize controls, such as

mesh expansion and transition factors, are available by
Main Menu>Preprocessor>Meshing>Size Cntrls>SmartSize>Adv Opts

7

%+ Global Element Sizing: Allows you to specify a maximum element edge
length for the entire model (or number of divisions per line):

Go to “Size Controls”, “Global” ,and click [Set] or
Main Menu>Preprocessor>Meshing>Size Cntrls > ManualSize

>Global >Size

MeshTool

Element Attributes:

[Giobal -] il

™ Smart Size
[
Fine

Size Controls:

N

Coarse

Global Set Cl

Areas Cl

Cl

ke

Copy Flip

el |

e

Layer Set Clear

Keupts Set Clear

hesh: I Yolumes 'l

Shape: % Tet = Hex

£ | b apped L SivEEn

I 3or 4 sided 'l

Mesh | Clear

Fiefine at: IElementS = l
Riefine |

33
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MaTtepuanbHble CBOUCTBA U eAUHULbI U3MEPEHUA B
ANSYS

Material Properties
Every analysis requires some material property input: Young’s modulus (EX), Poisson’s ratic
(PRXY) for structural elements, thermal conductivity (KXX) for thermal elements, etc.

To define the material properties:
Main Menu>Preprocessor>Material Props>Material Models

I Define
Material Models Defined Material Models Available
@ Material Model Mumber 1 J Farorites Linear Isofropic Material Properties for Material Mumber 1
# Structural
&8 Linear T1
8 Elastic
€ Orthotropic -~ l—
$ Anisotropic
MNonlinear
@ Density
& Thermal Expansion
g Darmping P Add Temperature ‘ Delete Temperature ‘ Grapt
£ FricHnon roafficiant
J J 0K ‘ Cancel ‘ Help
BT T I

More than one set of material properties can be defined when needed.

** Unit — The ANSYS program does not assume a system of units for your analysis.
You can use any system of units

34
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NMpumep: 3agayva CTPYKTYypHOro aHanusa

3apava o pacTshkeHUM nnacTuHbl. HanTu MmakcumMmanbHble
HanpsiKeHUs1 B NnacTuHe.

[ByMepHbIN cny4dan (Nockoe HanpsXXeHHOe COCTOAHME)
icnonb3oBaHWe CUMMETPUKN 3ada4n:; s NNACTUHDI

v

200 mm IN/mm

E = 200000 MPa
v=0.3

Diameter 5 mm

[IRRNEREE

1L

100 mm

3

Stress concentration at hole in plate ?
35



Ucnonb3oBaHue eguHuy usmepeHmnsa B ANSYS

m BaxHo: B cpege ANSYS Mechanical APDL (B otnuuue ot
ANSYS Workbench) eauHuubl usmepeHus He 3agaroTcs

m [lonb3oBaTenb AOJMKEH caM cneAuTb 3a COOTBETCTBUEM
eanHuU namepeHus!

« ANSYS knows nothing about the units you
are using

« It is important to be consistent

« For this example we will choose mm as
our unit of length and MPa for stress

 The consistent units of mass, time and
force are then grams, ms and N
respectively

36



"
NMpumep BxogHoro cpanna ana moaeribHOM 3agavm.
reHepauumsa onopHbIX TouekK (keypoints)

Iplate: ANSYS input file for plate with hole

FILNAM plate | Setz the filename — all output files will be named plate from now on
IPREPT | Enter the preprocessor — all geometry creation is done here
=T,1,PLAME42 | Define the element type - 4 node solid element, type help 42 for more info

UIMP.1.EX, | 200000, | Define matenal properties, this is the Young's modulus in the x direction
UIMP, 1. MUXY, | 0.3, 1Define materal properties, this is the value of Poisson’s ratio for the materia
7, 1.2.5.0, | Define keypoints, format is: k gnum, kx, Ky knum i the number of the point
K,2,1.768 1.768 | knum is the number of the point, kx is the x coordinate, ky i= the y coordinate
K, 3.0,2.5,,
4,100,
K,2,10,10,, s s :
K,5.0,10,,

7,500, KEYPOINT LOCATIONS
K,5,00,10,, 3
+,11,0,0,,

37
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NMpumep BxoagHoro channa gna moaesnibHOU 3a4auMm.

reHepauus NMHUN, oGrlacTen U KOHEYHO-
anemeHTHOUN ceTKM (lines, areas and FE mesh)

I Define arcs
I format iz lare, pt1,pi2,cnirradius
I Define straight lines between kypiz

LARC,1,2,11,2
LARC,2,3.11,2.
LETR
LETR
L5TR
LETR
L5TR
LSTR
LSTR
LSTR
AL 3G 4

=3
=

L B B

S = m e momon oo b

I Define areas using line numbers

i
o
Ll

oy 1
izes,,,1
ize,5,,, 1
ize,1,,,8
ize 2,8
ize,5,,,8
g
i
1

ize, 7,

i
m
o

IZ€,2,
ize, 9,

size, 10,

ih b f0 £ b EB £p b fp (P
W oW oW W W

amesh,1,3,7
| Then define boundary conditicns, loads

5 I Define mesh size

5 1'The number of elemaniz
2 liz specified per line

2

12

IhWMesh Areas

I Solve the model and post-process

LINE MUMBERS AMND {MEZH SIZING)

For ‘mapped mashing' we need consistent sizing n the drection of the
arows — this can reduce the number of elements and generaly
creates 3 better mesh

A+ BE) wmiz o,
J—F——1 1
5(15) / S(E) | (8]
' ! £y ——— >
2[8) _j_“:-' —'-I— —
1) '
g | N1z |
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CnusHue obLWMUX rpaHnL NPU UCMNOSIb30BaHUMN
reoMmeTpuyeckmx NnpuUMMTUBOB

Definition of model geometry

+ |f you define areas
and lines using BLC4
and other commands
like it, they will not
share boundaries

+ You can use
NUMMRG,all,tol to
merge commeon and after NUMMRG
boundaries (tol is the
tolerance, usually | P ,
use very small value)

and before NUMMRG
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3agaHue rpaHUYHbIX YCITOBUN. CUMMETpUS
(symmetry)

GRAPHICAL METHOD

Preproceasor = Loads = Define Loads = Apply = Structural = Displacement = Choose
and then pick the nodes (or lines) you want using the cursor

COMMAND METHOD

Select nodes by location using NSEL 2 loc, x min, max

where x, ¥ or Z is coordinale direction, min is the minimum value in this direcfion, max is the maximum
value (if anly one value iz given, just the nodes at this exact location are selected).

Apply DOF constraints to selected nodes using O nnum, DOF, val

where nnum is the number of the node o apply the constraint to (use all for all selected nodes), DOF is
the label of the DOF {in this case either UX or UY) and val is the value of the DOF,

eq. MN=SELslocx D

O, allux,0

To display the DOF constraintz on your model use the menu:
Plotetris = Symbols
and selzct the ‘ALL APPLIED BC2 option
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3agaHue rpaHUYHbIX YCITOBUN. coCpeaoTo4YeHHas
cuna (force)

GRAPHICAL METHOD

Freprocessor = Loads = Define Loads = Apply = Structural = Force/Moment = Choose
and then pick the nodes (or lines) you want using the cursor

COMMAND METHQD

Select nodes by location using NSEL s loc x min max

where x v or Z 15 coordinate direction, min 1s the minimum value in this direction, max is the maximum
value (If only one value is given, just the nodes at this exact location are selected).

Apply forces to selected nodes using F nnum, LAE val

where nnum is the number of the node to apply the force to (use all for all selected nodes), LAB is the
label of the force (in this case either FX or FY) and val is the value of the force.

eqg. NSEL s locx 560
F.all fx, 7?7
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"
3agaHue rpaHNYHbIX YCITIOBUM: fgaBneHue (pressure)

0 [aeneHue — 31O pacnpeneneHHas Harpyska (Surface Load)

GRAPHICAL METHOD

Preprocessor = Loads > Define Loads > Apply > Structural = Pressure > Choose
and then pick the nodes (or lines) you want using the cursor

COMMAND METHOD

Select nodes by location using NSEL s loc x, min.max

where x,y or Z i1s coordinate direction, min is the minimum value in this direction, max is the maximum
value (if only one value is given, just the nodes at this exact location are selected).

Apply pressures to selected nodes using SF nnum FPRES val

where nnum is the number of the node to apply the pressure to (use all for all selected nodes), PRES
tells ANSYS to apply a pressure and val is the value of the pressure.

eg. NSELslocx 50
SF,all PRES, 1"zthick
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"
KoHe4Hble 3neMeHTbI U UX OnuuK

« 2d structural element, PLANE 42

The nodal forces, if any, should be input per unit of depth for a plane
analysis (except for KEYOPT(3) = 3)

KEYOPT(3) defines element behavior:

0 = Plane stress (default) (stress in z direction = 0)

| = Axisymmetric

2 = Plane strain (strain in z direction = 0)

3 = Plane stress with thickness input

We want to calculate the plane stress solution, forces are per unit of depth in z
direction so the effective zthick = 1. So we should apply a pressure of 1*1 = 1.

We can set a different thickness value by setting KEYOPT,ITYPE,3,3 (ITYPE is
the element type number = 1) and R,/SET,THK (ISET is the real constant set
number = 1 and THK is the thickness value).

Positive pressures act into the element and we want to apply the load acting
out, therefore we apply a pressure of -1.
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KoHe4yHo-anemeHTHasi Moaenb € rpaHUYHbIMU
YyCINOBUSIMU, 3anyCK peLuaTtens

 \WWhat should the loaded model look like?

« S0 how we can solve the problem
GRAPHICAL METHOD

Select = Everything
Solution = Solve = Current LS

COMMAND METHOD

allsel
/solu
solve
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[MpoCcMOTpP N NMNCTUHT pe3ynbTaToOB B o0OLWeM
noctnpoueccope (General Postprocessor)

I
e

T
I a i

In the steady state we will only use the
General Postproc (/POST1) DOF solution = X-component of displacement
We can view results using commands, but it
is often easier to do this graphically
General Postproc > Read results > Last Set %
« A few examples: '
General Postproc > Plot results > Contour plot > Nodal Solution m.wr:;l e 2.7 T

Stress = X-component of stress

We can do this through:

List > Results > Nodal solution

General Postproc > List results > Nodal solution
This will list all selected nodes, so we might want to
select fewer nodes graphically or with NSEL

45



NMocT-npoueccopHaa o6paboTKa pe3ynbLTaToB B
Time history postprocessor gns HectauMoHapHOro
aHanusa (transient analysis)

TimeHist Postproc has a graphical
interface which lets us add varables
plot them

If we want to look at the variation of

displacement of a node with the appl
load we can add it as a variable

Fin Heln

and
| [T

5 HE B = e
- LEi

led

Type eplo to plot the elements of your

model, make sure you can see the region

you're interested in clearly
First click on + to add a new vanable

Then select the results type to add and

Aeei kem

8 Faories
o Modal Sobaticn
@ DOF Soution
@@ F-Congomeri of displacement
L=
B e

Aasu bem Properias
Yermble Mama 1Y 7

click OK

click OK
You should see a new variable has

Then select a node from the model and

Fle Hep

ol | B @) | riores

‘arishle Lisi

PLOT variable

Cancal |

o S N

LIST variable

Hp |

ha 51

] | Elernant
THE

| Huidns

|Rosd bam
Time

|Pinimum

|
Cakuiator
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pachnyeckoe oTodpaxeHue npouecca peLueHus
npun HectTauuMoOHapPHOM aHanuse

Measure of
change of
solution
variable
with each
iteration

Variable
type

Solution iteration number
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